Submission Template for ACM Papers

This is Short Title of the paper, used in page headers

This is the subtitle of the paper, this document both explains and embodies the submission format for authors using Word

First Author's Name, Initials, and Last name*
First author's affiliation, an Institution with a very long name, xxxx@gmail.com

Second Author's Name, Initials, and Last Name
Second author's affiliation, possibly the same institution, xxxx@gmail.com

Third Author's Name, Initials, and Last Name
Third author's affiliation, possibly the same institution, xxxx@gmail.com

Although there is no distinctive header, this is the abstract. This submission template allows authors to submit their papers for review to an ACM Conference or Journal without any output design specifications incorporated at this point in the process. The ACM manuscript template is a single column document that allows authors to type their content into the pre-existing set of paragraph formatting styles applied to the sample placeholder text here. Throughout the document you will find further instructions on how to format your text. If your conference’s review process will be double-blind: The submitted document should not include author information and should not include acknowledgments, citations or discussion of related work that would make the authorship apparent. Submissions containing author identifying information may be subject to rejection without review. Upon acceptance, the author and affiliation information must be added to your paper.

CCS CONCEPTS • Insert your first CCS term here • Insert your second CCS term here • Insert your third CCS term here

Additional Keywords and Phrases: Insert comma delimited author-supplied keyword list, Keyword number 2, Keyword number 3, Keyword number 4

ACM Reference Format:
First Author’s Name, Initials, and Last Name, Second Author’s Name, Initials, and Last Name, and Third Author’s Name, Initials, and Last Name. 2018. The Title of the Paper: ACM Conference Proceedings Manuscript Submission Template: This is the subtitle of the paper, this document both explains and embodies the submission format for authors using Word. In Woodstock ’18: ACM Symposium on Neural Gaze Detection, June 03–05, 2018, Woodstock, NY. ACM, New York, NY, USA, 10 pages. NOTE: This block will be automatically generated when manuscripts are processed after acceptance.

* Place the footnote text for the author (if applicable) here.
1 INTRODUCTION

ACM's new manuscript submission template aims to provide consistent styles for use across ACM publications, and incorporates accessibility and metadata-extraction functionality necessary for future Digital Library endeavors. Numerous ACM and SIG-specific templates have been examined, and their unique features incorporated into this single new template. If you are new to publishing with ACM, this document is a valuable guide to the process of preparing your work for publication. If you have published with ACM before, this document provides insight and instruction into the current process for preparing your manuscript.

This submission template allows authors to submit their papers for review to an ACM Conference or Journal without any output design specifications incorporated at this point in the process. The ACM “Submission Template” is a single column MS-Word document that allows authors to type their content into the pre-existing set of paragraph formatting styles applied to the sample placeholder text here, or copy-and-paste their text and then apply the respective paragraph styles (Windows: you can open the Styles task pane from the Home tab [it can also be opened with the keyboard shortcut Alt+Ctrl+Shift+S]; MAC16: you can access the Styles pane at the right of the Home toolbar.) Highlight a section that you want to designate with a certain style, and then select the appropriate style from the list. To view which style is being used in any part of this document, place your cursor on your text and look at the “Current style” field in the Styles pane.

It is beneficial to create your document in draft mode with the style panel open in the left-side panel. If the panel is not immediately visible when the Submission Template is opened, you will need to open the panel manually—for Windows: click on the following from the main ribbon above: File > Options > Advanced > Display > Style area pane width in Draft and Outline views. Set the style area width (1–1.5" is a good starting value.); for MAC: go to the “View” menu and select “Draft”; then go to the “Word” menu and select “Preferences” and then “View,” under the “Window” section insert “1.5” inches under the style area width.

All style elements are specified in this template to facilitate the production of your paper and to have the styles consistent throughout. The paragraph styles are built-in and examples of the styles are provided throughout this document. Save as you go and backup your work regularly!

1.1 Accessibility

Following the guidelines throughout this template will also improve the accessibility of your manuscript and increase the audience for your work. Ensure that heading styles are applied as instructed, tables are created using Word’s table feature (rather than an image), figures have a text equivalent, and list styles are applied as instructed.

To increase the accessibility of your manuscript, you should set the title and language metadata. On Word for Windows, open the File tab and click on Info. On Word for Mac, click the File Menu and select Properties, then click the Summary tab. Fill in the title of your document. For anonymous review, clear the ‘author’ field.

To set the document language, click the Review tab in the Ribbon. On Word for Windows: Click the Language button and select “Set Proofing Language.” Verify the language is set correctly. On Word for Mac: Click the Language button and select the document language from the pop-up.

1.2 More about the submission template

This submission version of your paper should not have headers or footers, these will be added when your manuscript is processed after acceptance. It should remain in a one-column format—please do not alter any of the styles or margins.
If a paper is accepted for publication, authors will be instructed on the next steps. Authors must then follow the submission instructions found on their respective publication’s web page. Once your submission is received, your paper will be processed to produce the formatted Word, PDF, and HTML5 output formats, which will be provided to you for review, revision/resubmission (if applicable), and approval.

### 1.3 Inserting CCS concepts

The new template enables you to import required indexing concepts for your article from the ACM Computing Classification System (CCS) using an indexing support tool found in the ACM Digital Library (DL). The tool generates formatted text after you have selected your terms. To insert CCS terms into your document, copy and paste the formatted text from the CCS tool using the “https://dl.acm.org/ccs/ccs.cfm” link into the “CCS CONCEPTS” section.

An additional step is necessary to ensure that the proper CCS terms are added to the Digital Library citation page: from the “view CCS TeX Code” listing, click on “Show the XML Only.” Highlight and copy the XML code from the window. You must insert the XML code into your Word document’s properties: from your Word document, click on “File”, then click on the “Info” tab on the left-hand side panel, then click “Properties” and select “Show All Properties.” Click within the “Comments” metadata field and paste the XML data.

### 2 INSERTING CONTENT ELEMENTS

The next subsections provide instructions on how to insert figures, tables, and equations in your document.

#### 2.1 Tables

Tables are “float elements” which should be inserted after their first text reference and have specific styles for identification. Do not use images to present tables, or they will be inaccessible to readers using assistive technologies.

Authors can insert tables by using the MS Word option (INSERT ->Table) and providing the required row and column size. Every table must have a caption (title) above it, which must have the “Caption” style applied. Please note that tables should not be supplied as image files, but if they are images they must have the “Image” style applied.

As an example, Table 1 shows all the styles available in this template, to be applied to the respective element of your text.

<table>
<thead>
<tr>
<th>Style Tag</th>
<th>Definition</th>
<th>Style Tag</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title_document</td>
<td>main title of article</td>
<td>ListParagraph</td>
<td>list items</td>
</tr>
<tr>
<td>Subtitle</td>
<td>subtitle of article</td>
<td>Statements</td>
<td>math statements</td>
</tr>
<tr>
<td>Authors</td>
<td>author name</td>
<td>Extract</td>
<td>block quotations</td>
</tr>
<tr>
<td>Affiliation</td>
<td>author affiliation information</td>
<td>Algorithm</td>
<td>caption for algorithm</td>
</tr>
<tr>
<td>AuthNotes</td>
<td>footnote to author(s)</td>
<td>AckHead</td>
<td>heading for acknowledgements</td>
</tr>
<tr>
<td>Abstract</td>
<td>abstract text</td>
<td>AckPara</td>
<td>acknowledgements text</td>
</tr>
<tr>
<td>CCSHead</td>
<td>heading for CSS Concepts</td>
<td>GrantSponsor</td>
<td>sponsor of grant</td>
</tr>
<tr>
<td>CCSDescription</td>
<td>CSS terms</td>
<td>GrantNumber</td>
<td>number for the grant</td>
</tr>
<tr>
<td>KeyWordHead</td>
<td>heading for keywords</td>
<td>ReferenceHead</td>
<td>heading for references</td>
</tr>
<tr>
<td>Keywords</td>
<td>keywords text</td>
<td>Bib_entry</td>
<td>references</td>
</tr>
<tr>
<td>ORCID</td>
<td>author's ORCHID #</td>
<td>AppendixH1</td>
<td>appendix heading level 1</td>
</tr>
<tr>
<td>Head1</td>
<td>heading level 1</td>
<td>AppendixH2</td>
<td>appendix heading level 2</td>
</tr>
<tr>
<td>Head2</td>
<td>heading level 2</td>
<td>AppendixH3</td>
<td>appendix heading level 3</td>
</tr>
<tr>
<td>Head3</td>
<td>heading level 3</td>
<td>TableCaption</td>
<td>title of table</td>
</tr>
</tbody>
</table>

Table 1: Styles available in the Word template
Tables can be very difficult for people using screen reader technology to understand unless they include markup that explicitly defines the relationships between all the parts (i.e.: headers and data cells). A key to making data tables accessible to screen reader users is to clearly identify column and row headers. In Word, authors should identify which row or rows contain column headers. Below are the steps to do this:

1. Select that table’s row, then right-click the row and select “Table Properties”;
2. In the Table Properties window, click the Row tab and select the box that says “Repeat as header row at the top of each page.”

Or

Apply the “table head” style by highlighting the respective row and applying the “TableHead” style found in the “Body Element” section of the ACM Master Article Template.

2.2 Figures

Figures are “float elements” which should be inserted after their first text reference, and have specific styles for identification. Insert a figure and apply the “Image” paragraph style to it. For the figure caption, apply the style “FigureCaption.”

To accommodate readers with color vision differences, figures should still be usable when printed in grayscale. Refer to elements of the figure with non-color terms, for example “indicated as squares” instead of “indicated in blue”. Use different patterns in bar charts, different line patterns in graphs, and different shapes in plots to distinguish groups of elements and reinforce color differences.

2.2.1 Half Width Figures.

Figure 1 is an example of a figure and caption spanning the half-page width (one column in a two column format) with the styles applied. If your figure contains third-party material, you must clearly identify it as such, as shown in the example below.
2.2.2 Full Width Figures.

Figure 2 is an example of a figure and caption spanning the full-page width with the styles applied. If your figure contains third-party material, you must clearly identify it as such, as shown in the examples.
2.2.3 Multi-part figure.

Authors can also insert a multi-part figure above a single caption. Every inserted figure must have the “Image” style applied. Below are instructions regarding how to insert a multi-part figure in your paper:

- If the author wants to insert two multi-part images, they must draw a one row and one column table and insert the images one-by-one in the cells.
- If the author wants to insert three multi-part images, they must draw a one-row and three-column table and insert the images one by one in all three cells.
- If the author wants to insert four multi-part images, they must draw a two-row and two-column table and insert the images one-by-one in all four cells. (see the following example):
2.2.4 Figure Descriptions.

Every figure should have a figure description unless it is purely decorative. These descriptions convey what’s in the image to someone who cannot see it. They are also used by search engine crawlers for indexing images, and when images cannot be loaded.

A figure description must be unformatted plain text less than xxx characters long. Figure descriptions should not repeat the figure caption – their purpose is to capture important information that is not already provided in the caption or the main text of the paper. For figures that convey important and complex new information, a short plain text description may not be adequate. More complex alternative descriptions can be placed in an appendix and referenced in a short figure description. For example, provide a data table capturing the information in a bar chart, or a structured list representing a graph. For additional information regarding how best to write figure descriptions and why doing this is so important, please see https://www.acm.org/accessibility.

The instructions below describe the required steps authors need to follow in order to insert descriptive text for figures (alt-txt value) in MS Word 2019 on Windows or Word 2016 and later on Mac:

1. Insert a picture in the document.
2. Right-click the image and select “Edit Alt Text”.
3. In the “alt text” section, provide your text description of the image.

Below are the steps to insert figure descriptions in MS Word 2013 and 2016:

1. Insert a picture in the document.
2. Right click on the inserted picture and select the Format Picture option.
3. In the settings at the right side of the window, click on the “Layout & Properties” icon (3rd option).
4. Expand Alt Txt option.
5. In the “Title” and “Description” text boxes, type the text you want to represent the figure, and then click “Close.”

Below are steps to insert the alt-txt value in MS Word 2010/2011 for Windows*:

1. Insert a picture in the document.
2. Right click on the inserted picture and select the **Format Picture** option.
3. Select the **Alt Txt** option from the left-side panel options.
4. In the “Title” and “Description” text boxes, type the text you want to represent the picture, and then click “Close.”
   * The Mac 2011 version 14.0.0 and later allows the option for inserting “alt-text.” In the MAC version of Word 2016, right-click on the image and select “Edit Alt Text” from the pop-up menu and then enter the description for the alt text.

### 2.3 Quotations and Extracts

There are styles for block quotations, which should be used for quotes that are separated from in-line text. Below is an example.

> “Microsoft tried to revive the idea of an assistant with Clippy, who began popping up in Microsoft Office in 1997. Its creator, Kevan Atteberry, was actually contracted by Microsoft to design Clippy, which, funnily enough, he did on a Mac … Sure, people could disable Clippy, but the fact he was on by default angered people.” [10]

### 2.4 Equations

There are two types of math equations: the *numbered display math equation* and the *un-numbered display math equation*. Below are examples of both.

#### 2.4.1 DisplayFormula.

The **DisplayFormula** style is applied in the numbered math equation. A numbered display equation always has an equation number (label) on the right.

\[
x = \frac{-b \pm \sqrt{b^2 - 4ac}}{2a}
\]  
(1)

#### 2.4.2 DisplayFormulaUnnum.

The **DisplayFormulaUnnum** style is applied only in unnumbered equations. An unnumbered display equation never contains an equation number Bertot and Grimes (2012) on the right—this element distinguishes it from the numbered equation.

\[
x = -b \pm \sqrt{b^2 - 4ac}
\]

Please note: the subsequent text after the **DisplayFormula** (numbered equation) or **DisplayFormulaUnnum** (unnumbered equation) must have the paragraph style **ParaContinue** applied.

### 2.5 Math statements

Math statements should have the “Statement” style applied.

**Theorem/Proof/Lemma.** Math statements should have the “**Statement**” style applied. This paragraph is an example of the “**Statement**” style.
2.6 Algorithms

Algorithms use the styles “AlgorithmCaption” and “Algorithm”.

---

**ALGORITHM 1: Iterative Algorithm**

```
current_position    center
current_direction    up

while current_position is inside circle, do
    neighborhood all grid hexes within two hexes from current_position
    for each hex in neighborhood, do
        for each neuron in hex do
            convert neuron_orientation to vector
            scale vector by neuron_excitation
            vector_sum vector_sum + vector
        end
    end
end
normalize vector_sum
```

---

3 COMPUTER CODE

Display Computer codes can be inserted using “ComputerCode” style.

**CHAT Start**

```
SAY Welcome to my world
WAIT 1.2
SAY Thanks for Visiting
ASK Do you want to play a game?
OPT Sure
OPT No Thanks
```

Similary, this is an example of intext code text.

4 CITING RELATED WORK

This section cites a variety of journal [5, 15], conference [1, 6, 8, 12, 13], and magazine [3] articles to illustrate how they appear in the references section. It also cites books [9, 10], a technical report [7], a PhD dissertation [4], an online reference [14], a software artifact [11], and a dataset [2].

As you build your article, you should note where you will be placing citations. If you are using numbered citations and references, the reference number - "...as shown in [5]..." is sufficient. If you are using the "author year" style, a
reasonable placeholder is the primary author's last name and the year of publication - "...as shown in [Harel 1978]..." - we will be updating this placeholder later in the process with the citation label as generated by the Word macros in the "master template.

ACKNOWLEDGMENTS

Acknowledgments are placed before the references. Add information about grants, awards, or other types of funding that you have received to support your research. Author can capture the grant sponsor information, by selecting the grant sponsor text and apply style ‘GrantSponsor’. After this, select grant no and apply ‘GrantNumber’ from style panel. Example of Grant sponsor: Competitive Research Programme and example of Grant no: CRP 10-2012-03.

REFERENCES


A APPENDICES

In the appendix section, three levels of Appendix headings are available.

A.1 General Guidelines (AppendixH2)

1. Save as you go and backup your file regularly.
2. Do not work on files that are saved in a cloud directory. To avoid problems such as MS Word crashing, please only work on files that are saved locally on your machine.
3. Equations should be created with the built-in Microsoft® Equation Editor included with your version of Word. (Please check the compatibility at http://tinyurl.com/lzny753 for using MathType.)
4. Please save all files in DOCX format, as the DOC format is only supported for the Mac 2011 version.
5. Tables should be created with Word’s “Insert Table” tool and placed within your document. (Tables created with spaces or tabs will have problems being properly typeset. To ensure your table is published correctly, Word’s table tool must be used.)
6. Do not copy-and-paste elements into the submission document from Excel such as charts and tables.
7. Footnotes should be inserted using Word’s “Insert Footnote” feature.
8. Do not use Word’s “Insert Shape” function to create diagrams, etc.
9. Do not have references appear in a table/cells format as it will produce an error during the layout generation process.
10. MS Word does not consistently allow the original formatting to be modified in the text. In these cases, it is best to copy all the document’s text from the specific file and paste into a new MS Word document and then save it.
11. At times there are font problems such as “odd” stuff/junk characters that appear in the text, usually in the references. This can be caused by a variety of reasons such as copying-and-pasting from another file, file transfers, etc. Please review your text prior to submission to make sure it reads correctly.

A.1.1 Preparing Graphics (AppendixH3)

1. Accepted image file formats: TIFF (.tif), JPEG (.jpg).
2. Scalable vector formats (i.e., SVG, EPS and PS) are greatly preferred.
3. Application files (e.g., Corel Draw, MS Word, MS Excel, PPT, etc.) are NOT recommended.
4. Images created in Microsoft Word using text-box, shapes, clip-art are NOT recommended.
5. IMPORTANT: All fonts must be embedded in your figure files.
6. Set the correct orientation for each graphics file.

A.2 Placeholder Text


Enim eu turpis egestas pretium. Nulla aliquet enim tortor at auctor urna. Id aliquet enim pretium tortor at auctor urna. Id aliquet enim pretium tortor at auctor urna. Id aliquet enim pretium tortor at auctor urna. Id aliquet enim pretium tortor at auctor urna.
ultrices neque ornare. Egestas purus viverra accumsan in nisl nisi scelerisque eu ultrices. Tempus urna et pharetra pharetra massa massa. Pulvinar neque laoreet suspendisse interdum consectetur libero id.


